Installation on UNIX Systems

June 2003
Notice

The information contained in this document is subject to change without notice.

Agilent Technologies makes no warranty of any kind with regard to this material, including, but not limited to, the implied warranties of merchantability and fitness for a particular purpose. Agilent Technologies shall not be liable for errors contained herein or for incidental or consequential damages in connection with the furnishing, performance, or use of this material.

Warranty

A copy of the specific warranty terms that apply to this software product is available upon request from your Agilent Technologies representative.

Restricted Rights Legend

Use, duplication or disclosure by the U. S. Government is subject to restrictions as set forth in subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 for DoD agencies, and subparagraphs (c) (1) and (c) (2) of the Commercial Computer Software Restricted Rights clause at FAR 52.227-19 for other agencies.

Agilent Technologies
395 Page Mill Road
Palo Alto, CA 94304 U.S.A.


Acknowledgments

Mentor Graphics is a trademark of Mentor Graphics Corporation in the U.S. and other countries.

Microsoft®, Windows®, MS Windows®, Windows NT®, and MS-DOS® are U.S. registered trademarks of Microsoft Corporation.

Pentium® is a U.S. registered trademark of Intel Corporation.

PostScript® and Acrobat® are trademarks of Adobe Systems Incorporated.

UNIX® is a registered trademark of the Open Group.
Contents

1 Before You Begin

   Note the Changes in RFDE 2003A ................................................................. 1-2
   Check the System Requirements ................................................................. 1-3
   Get Codeword for RF Design Environment .............................................. 1-5
   Backup Your Data ....................................................................................... 1-9
   Check Available Disk Space ....................................................................... 1-9

2 Installing RF Design Environment

   Installation Overview .................................................................................. 2-2
   Installation Steps ....................................................................................... 2-3
   Configuring User Accounts ........................................................................ 2-8
      Setting Ownships and Permissions ......................................................... 2-9
      Setting the RFDE Product License Variable ........................................... 2-9
      Defining the RFDE Libraries ................................................................. 2-11
      Setting Proxies in Netscape ................................................................. 2-12
   Changes in the Cadence Installation Directory .......................................... 2-13

3 Setting Up Licenses

   Installing Licenses ..................................................................................... 3-2
      Save the License File ............................................................................ 3-3
      Edit the License File ............................................................................. 3-3
      Place License File .................................................................................. 3-11
      Start the License Server (lmgrd) ............................................................ 3-12
      Provide Access to Licenses ................................................................... 3-15
   Using a UNIX-to-PC Floating License ...................................................... 3-17
   Automating FLEXlm License Manager Startup ....................................... 3-17
   Selecting a License Bundle ....................................................................... 3-19
   Special Licensing Needs ........................................................................... 3-20
      Using FLEXlm Options ......................................................................... 3-20
      Updating the License File ..................................................................... 3-23
      Merging Multiple Vendor Licenses ....................................................... 3-23
      Redundant License Servers .................................................................... 3-27
      Controlling License Path Settings ....................................................... 3-27
   Using the Agilent License Information Tool ............................................. 3-31
4 Using RF Design Environment
   Running RF Design Environment................................................................. 4-1
   Using the Agilent License Preference Tool.................................................. 4-1
   Using a Custom Startup Script.................................................................... 4-7
   If RF Design Environment Does Not Start.................................................. 4-7
   Using RFDE with Multiple Versions of Cadence......................................... 4-8
   Printing and Plotting .................................................................................. 4-9
   Printing From UNIX .................................................................................... 4-9
   Adding a Printer............................................................................................ 4-9
   Common Licensing Problems....................................................................... 4-14
   Where to Begin............................................................................................. 4-14
   Common Errors and Solutions ................................................................... 4-15
   Agilent EEs of Technical Support ................................................................ 4-20

Index
Chapter 1: Before You Begin

Before you begin, please take the time to go over the guidelines for installing Agilent RF Design Environment (RFDE) on a UNIX system. For last-minute installation information, see the file README.TXT, included on the installation disk. For last-minute program and documentation information, refer to the Release Notes document on our website at:

http://www.agilent.com/find/eesof-docs

Choose RF Design Environment > Manuals > Release Notes
Before You Begin

**Note the Changes in RFDE 2003A**

*Important* If you have systems running an older version of RFDE, see Table 1-1 for a brief description of changes in RFDE 2003A and their impact on systems with the older version installed.

<table>
<thead>
<tr>
<th>Description and Reference to Details</th>
<th>Impact</th>
</tr>
</thead>
<tbody>
<tr>
<td>License Packages are replaced by Bundles. The Bundle licenses work only if users select them by running the Agilent License Preference tool prior to starting RFDE. See “Using the Agilent License Preference Tool” on page 4-1.</td>
<td>Impacts all license servers using license bundles. This does <em>not</em> impact node-locked and floating-license files.</td>
</tr>
<tr>
<td>The FLEXlm version for license server (lmgrd) is 8.2a. See “Start the License Server (lmgrd)” on page 3-12.</td>
<td>Impacts all systems, and license administration scripts.</td>
</tr>
<tr>
<td>The vendor daemon changed from agileesof to agileesofd, and the environment variable AGILEESOF_LICENSE_FILE changed to AGILEESOFD_LICENSE_FILE. See “Installing Licenses” on page 3-2.</td>
<td>Impacts all license servers and client systems.</td>
</tr>
<tr>
<td>The codeword version changed from 2.0 to 2.3. The codewords are version-dependent. They will enable RFDE 2003A only. See “Installing Licenses” on page 3-2.</td>
<td>You must obtain new FLEXlm license codewords from Agilent EEsof EDA.</td>
</tr>
<tr>
<td>Supported platforms changed. See “Check the System Requirements” on page 1-3.</td>
<td>Solaris 9 support is added. IBM AIX is no longer supported.</td>
</tr>
</tbody>
</table>
Check the System Requirements

The hardware and software configuration requirements for Cadence Analog Design Environment are sufficient for RF Design Environment in most areas. In other areas, RFDE has specific requirements. Be sure your hardware and software configuration meets the following minimum hardware and system requirements to install and/or run RF Design Environment. Keep in mind that minimum requirements are just that, and they may not provide adequate performance and responsiveness.

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Sun</th>
<th>HP 9000-700</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>Solaris 7, 8, 9</td>
<td>HP-UX 11.0 and 11i with the</td>
</tr>
<tr>
<td></td>
<td>Note: Sun operating systems are</td>
<td>following patches:</td>
</tr>
<tr>
<td></td>
<td>not supported on Intel-compatible</td>
<td>- PHSS_24627 HP aC++ -AA</td>
</tr>
<tr>
<td></td>
<td>chips.</td>
<td>Runtime Libraries (aCC A.03.33)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- PHSS_25718 LIBCL</td>
</tr>
<tr>
<td>Design Environment</td>
<td>Cadence DFII versions: 4.4.5 QSR4, 4.4.6 MSR8, 5.0 MSR3</td>
<td></td>
</tr>
<tr>
<td>Cadence Context Files</td>
<td>&lt;Cadence_installation_dir&gt;/tools/dfii/etc/context/spectrei.cxt</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;Cadence_installation_dir&gt;/tools/dfii/etc/context/asimenv.cxt</td>
<td></td>
</tr>
<tr>
<td></td>
<td>If either of these files is missing, contact Cadence Design Systems, Inc. for information on how to install it.</td>
<td></td>
</tr>
<tr>
<td>Displays</td>
<td>High-resolution color only.</td>
<td></td>
</tr>
<tr>
<td>RAM</td>
<td>The requirements specified for Cadence Analog Circuit Design Environment are sufficient for RF Design Environment.</td>
<td></td>
</tr>
<tr>
<td>Swap Space</td>
<td>The requirements specified for Cadence Analog Circuit Design Environment are sufficient for RF Design Environment. Additional swap space may be required depending on the size and complexity of the design you are simulating.</td>
<td></td>
</tr>
<tr>
<td>Web Browser</td>
<td>RF Design Environment documentation is HTML-based and displayed via a web browser. RFDE installs Netscape 4.7x, and Agilent recommends that you use this installed version. If you use a different version, Netscape version 4.5 or higher is required. Make sure any older, unsupported versions you may have are not in your path ahead of the RFDE installation.</td>
<td></td>
</tr>
<tr>
<td>Hard Disk Space</td>
<td>RF Design Environment requires about 800 MB of free disk space on HP-UX systems, and 600 MB on Solaris systems.</td>
<td></td>
</tr>
<tr>
<td>Security Device</td>
<td>An RF Design Environment software codeword is locked to an individual computer ID number.</td>
<td></td>
</tr>
</tbody>
</table>
Before You Begin

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Sun</th>
<th>HP 9000-700</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported Printers/Plotters</td>
<td>RF Design Environment uses the same printer support as Cadence Analog Circuit Design Environment when setting up and running simulations. When displaying results, RFDE uses Xprinter for all PostScript®, HPGL2 and PCL printing. For a complete list of output devices supported with Xprinter, consult the text file called filename_map.txt, located in the directory path: &lt;installation directory&gt;/xprinter/ppds. For instructions on UNIX printing and plotting, refer to “Printing and Plotting” on page 4-9 in Chapter 4, Using RF Design Environment.</td>
<td></td>
</tr>
<tr>
<td>Supported Media Type</td>
<td>CD-ROM</td>
<td></td>
</tr>
<tr>
<td>Window Manager</td>
<td>RF Design Environment uses the same window managers that Cadence Analog Circuit Design Environment uses on each platform.</td>
<td></td>
</tr>
</tbody>
</table>

Checking the Operating System

To determine the version that you are currently running, at the system prompt type:

```
uname -r  (All UNIX platforms)
```
Get Codeword for RF Design Environment

You must obtain a new FLEXlm license codeword to run the particular RF Design Environment product you purchased. While the installation program will install components for all available RFDE products, you will be able to run only those for which you have a license.

A Codeword Request form is included with your installation media. Please fill it out completely and fax it to the number on the form. You can also request licenses or codewords on the Web at:

   http://www.agilent.com/find/eesof-support

   Choose Codeword Request

The codewords are emailed to you in a license file called license.lic.

The hardware key is generally shipped with the software disks. If you do not have one, contact Agilent EEsof Business Support at 1-800-507-6274.

For details on both methods of securing codewords refer to Chapter 3, Setting Up Licenses.

**Important** When requesting licenses for HP-UX 11.x systems from Agilent, avoid keying licenses to the LAN ID/MAC address. Globetrotter does not recommend using an ethernet address for the hostid on HP-UX 11.x systems.

Table 1-2 shows the RF Design Environment products and their capabilities. Each product requires its own license. The installation program installs all of the listed components, and you must obtain and install the correct license for the particular product you purchased.
Table 1-2. RF Design Environment Products

<table>
<thead>
<tr>
<th>RFDE Wireless Pro</th>
<th>RFDE Wireline Pro</th>
<th>RFDE Premier†</th>
<th>Capability</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>RFDE Integration</strong></td>
</tr>
<tr>
<td>x</td>
<td>x</td>
<td>x</td>
<td>Cadence Analog Design Environment Integration</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Simulation Capabilities (ADSsim)</strong></td>
</tr>
<tr>
<td>x</td>
<td>x</td>
<td>x</td>
<td>Data Analysis &amp; Display</td>
</tr>
<tr>
<td>x</td>
<td>x</td>
<td>x</td>
<td>Parameter Sweep</td>
</tr>
<tr>
<td>x</td>
<td>x</td>
<td>x</td>
<td>Parameter Optimization</td>
</tr>
<tr>
<td>x</td>
<td>x</td>
<td>x</td>
<td>Monte Carlo / Yield Analysis / Sensitivity</td>
</tr>
<tr>
<td>x</td>
<td>x</td>
<td>x</td>
<td>DC Analysis</td>
</tr>
<tr>
<td>x</td>
<td>x</td>
<td>x</td>
<td>AC Analysis</td>
</tr>
<tr>
<td>x</td>
<td>x</td>
<td>x</td>
<td>S-Parameter Analysis</td>
</tr>
<tr>
<td>x</td>
<td>x</td>
<td>x</td>
<td>Small Signal Noise Analysis</td>
</tr>
<tr>
<td>x</td>
<td>x</td>
<td>x</td>
<td>Transient Analysis</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Transient Analysis with Convolution</td>
</tr>
<tr>
<td>x</td>
<td></td>
<td>x</td>
<td>HB Analysis</td>
</tr>
<tr>
<td>x</td>
<td></td>
<td>x</td>
<td>Transient Assisted HB Analysis</td>
</tr>
<tr>
<td>x</td>
<td></td>
<td>x</td>
<td>Nonlinear Noise Analysis</td>
</tr>
<tr>
<td>x</td>
<td></td>
<td>x</td>
<td>Phase Noise Analysis</td>
</tr>
<tr>
<td></td>
<td></td>
<td>x</td>
<td>Circuit Envelope Analysis</td>
</tr>
</tbody>
</table>

† The RF Design Environment Premier+ product is also available. See “RF Design Environment Premier+” on page 1-8 for a description.
<table>
<thead>
<tr>
<th></th>
<th>RFDE Wireless Pro</th>
<th>RFDE Wireline Pro</th>
<th>RFDE Premier†</th>
<th>Capability</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Library Components (ADSlib)</strong></td>
<td></td>
<td></td>
<td></td>
<td>Frequency domain sources</td>
</tr>
<tr>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td>Time domain sources</td>
</tr>
<tr>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td>Modulated sources</td>
</tr>
<tr>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td>Noise sources</td>
</tr>
<tr>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td>Voltage/Current controlled sources</td>
</tr>
<tr>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td>Lumped components</td>
</tr>
<tr>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td>Transistor components</td>
</tr>
<tr>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td>Data Items (S-parameter files)</td>
</tr>
<tr>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td>Microstrip T-Lines</td>
</tr>
<tr>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td>Multilayer T-Lines</td>
</tr>
<tr>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td>Passive RF components (bond wires, transformers)</td>
</tr>
<tr>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td>Filter components</td>
</tr>
<tr>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td>Amplifier components</td>
</tr>
<tr>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td>Mixer components</td>
</tr>
<tr>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td>PLL components</td>
</tr>
</tbody>
</table>

† The RF Design Environment Premier+ product is also available. See “RF Design Environment Premier+” on page 1-8 for a description.
Before You Begin

RF Design Environment Premier+

The RF Design Environment Premier+ product is a combination of RF Design Environment and Advanced Design System licenses. This product enables the use of Agilent Ptolemy and Momentum simulators, which are not natively supported in any of the other RFDE products. Agilent Ptolemy is a system simulator used for verifying RF/baseband performance by running co-simulations with Circuit Envelope. Momentum is a 2.5D electromagnetic simulator used for generating accurate frequency domain models for passive layout structures.

RF Design Environment Premier+ adds the following ADS licenses to the RFDE Premier product:

- ADS Project Design Environment
- Ptolemy Simulator (for RF/baseband co-simulation)
- Antenna & Propagation Models (for use with Ptolemy)
- Momentum Simulator (for modeling of passive layout structures)
- Momentum Visualization
- Momentum Optimization
- ADS Layout (for setting up Momentum simulations)
- GDSII Translator (for importing layout elements from Cadence into ADS Layout)

If you plan to install ADS and RFDE, be aware that they each have their own installation process. Install ADS first, then install RFDE in the same directory. For more installation information, see the ADS Installation on UNIX Systems manual.

**Important** A license for RFIC Dynamic Link for Cadence is also included with all RFDE products. However, Dynamic Link can be used only when ADS is installed.

To use RF Design Environment and Advanced Design System together (e.g., through Dynamic Link) you must install both products in the same directory. Also, Agilent recommends that you install ADS first, then install RFDE. The ADS product has a separate installation process. For information about installing ADS, see the ADS Installation on UNIX Systems manual.
Additional License Requirements

In addition to licenses for RFDE and other related Agilent EEs of products you may use (such as ADS and RFIC Dynamic Link), the following Cadence product licenses are also required:

- OASIS_Simulation_Interface 34510
  The OASIS license is provided by Cadence for free to RFDE customers.
- Affirma™ analog design environment 300
- Virtuoso® layout editor (if using layout)

You must obtain all required Cadence licenses from Cadence Design Systems. For Cadence contact information, see their web site at:


Backup Your Data

You can retain installations of other RF Design Environment versions in separate directories on the same machine, but you cannot install a newer version over a previous installation. This also applies to an Early Access (Beta) version.

Check Available Disk Space

Your system must have enough disk space available to install RF Design Environment. The amount of disk space required depends on the platform you are using, and is specified in “Check the System Requirements” on page 1-3. The installation program will confirm if there is enough space. To display the available disk space, at the prompt enter the command for the workstation you are using:

<table>
<thead>
<tr>
<th>Workstation</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP-UX 11</td>
<td>bdf</td>
</tr>
<tr>
<td>Solaris 7/8/9</td>
<td>df -k</td>
</tr>
</tbody>
</table>

Note   RF Design Environment requires at least 20-30 MB of free disk space under /tmp and /var/tmp to work properly.
Before You Begin

**Defining an Installation Location**

Be sure you have permissions to write to the disk partition on which you want to install RF Design Environment. Additionally,

- You do not need to install as root, although you may need root privileges to mount and unmount the installation CD-ROMs.
- If installed as root, verify that all RFDE files have at least read and execute permissions for all users.
- You will need a mount point directory for the CD-ROM.
- You will need the path to the Cadence installation that will be used with RF Design Environment.
- If you plan to use both ADS and RFDE, they are designed to be installed in the same directory. Install ADS first, then install RFDE in the same directory. Each has its own individual installation process.

For details on install steps and options for RFDE, refer to Chapter 2, Installing RF Design Environment.

---

**Note**  The installation program does not support cross-platform installations.
Chapter 2: Installing RF Design Environment

Use the following information for installing RF Design Environment on UNIX systems. For last-minute installation information, see the file README.TXT, included on the installation disk. For last-minute program and documentation information, refer to the Release Notes document on our website at:

http://www.agilent.com/find/eesof-docs

Choose RF Design Environment > Manuals > Release Notes
Installing RF Design Environment

Installation Overview

1. Obtain Codewords
2. Mount installation CD
3. Run Setup program
4. Install program files
5. Add Codewords to license file and start FLEXlm

**Will you use License Bundles?**

- Yes
  - Select License Bundle using Agilent License Preference Tool
- No
  - Launch RF Design Environment
Installation Steps

Use the following steps for installing RF Design Environment on UNIX systems. If you have not done so, please review Chapter 1, Before You Begin.

**Important** If you plan to use RF Design Environment and Advanced Design System together (e.g., Dynamic Link) you must install both products in the same directory. Also, Agilent recommends that you install ADS first, then install RFDE. The ADS product has a separate installation process. For information about installing ADS, refer to the ADS installation guide, Installation on UNIX Systems.

**Notes** If you installed the Early Access version of RF Design Environment, you must specify a different installation directory for this version of RF Design Environment. If the Early Access version was installed directly into a Cadence installation directory, you must reinstall Cadence before installing RF Design Environment. If the Early Access version was installed into a shadow directory containing symbolic links to a Cadence installation, create a new shadow directory.

The installation program does not support cross-platform installations.

To install RF Design Environment on UNIX systems:

1. Log onto the system using an account that has permissions to write to the disk you want to install to.

2. Mount the RF Design Environment CD-ROM making sure to use the correct CD-ROM for your platform. Mounting a CD-ROM file system on a UNIX system requires root or super-user privileges on most UNIX systems.

**Note** If you are running Solaris 7/8/9 and the CD-ROM has been mounted by vold, you can skip to step 3. You can check if the CD-ROM is mounted by running the mount command without any arguments.
Installing RF Design Environment

The typical mount point, or directory, for a CD-ROM is /cdrom. This may be different on your UNIX system. The mount point directory must exist before you can mount the CD-ROM. To create a /cdrom directory, type:

```
mkdir /cdrom
```

To mount the Program CD-ROM, run the command for your system. Here are examples:

```
mount -rF cdfs /dev/dsk/c201d2s0 /cdrom  (HP-UX 11.x)
mount -F hsfs -r /dev/dsk/c0t6d0s0 /cdrom (Solaris 7/8/9 not running vold)
```

Once the Program CD-ROM is mounted, exit from being root before completing the rest of the installation procedure if you do not want to install as root.

3. Change directory to the cdrom subdirectory on the Program CD-ROM.

```
 cd /cdrom
```

**Note** If you are running Solaris 7/8/9, and the vold daemon is active, type:

```
 cd /cdrom/cdrom0
```

If you are not installing as the user root you will also need to set the umask command to: `umask 000`

4. Start the installation program using the command:

```
./SETUP.SH
```

**Note** If you are running Netscape, or another program that uses a lot of color resources, you should shut it down before starting the RF Design Environment installation program.

5. The installation wizard appears. There are seven wizard screens to guide you through the installation setup. The Welcome screen is first. Follow the instructions in each screen and click Next to progress through the installation setup.
6. The License Agreement screen is next. This is a usage agreement, and has no impact on license codewords required to run RFDE. Select I accept this license agreement to proceed with the installation.

7. The Collect Information 1/2 screen is next. Enter two path specifications:

• Enter the path to the location where you want to install RF Design Environment. You must have write permission and sufficient disk space. The installation program will verify sufficient disk space is available.

• Enter the path to the Cadence installation from which you will use RF Design Environment.

Note  If you are running Solaris 7/8/9, and the vold daemon is active, you may see the # symbol in the path while browsing for either of these installation locations. This symbol can set up an incorrect path. To avoid this symbol:

Click Cancel in the RFDE installation wizard.
Log in as root.
Kill the vold process.
Restart the vold process.
Return to step 1.
8. The Collect Information 2/2 screen is next.

Some RF Design Environment files must be installed in the Cadence installation directory. Choose how you want to install RF Design Environment. Remember this path which you will use later to set the environment variable CADENCE_DIR when configuring user accounts and in your RFDE start-up script. Your options are:

- Install these files directly in the Cadence installation directory.
  This modifies the Cadence directory. To use this option, you must have write permissions to the directory. Files are installed only in the Cadence directory in your path. If you have multiple Cadence installations, RFDE files are installed in only one of them.

- Install these files in a separate directory of symbolic links that shadows the Cadence directory.
  If you use a shadow directory, and you also use a shell script to run Cadence, the shell script will not be updated to point at the shadow directory. You must manually update the shell script to point at the new shadow directory. Only one Cadence installation can be shadowed. If you have multiple Cadence installations, it is necessary to create one shadow for each Cadence installation.

9. The Summary screen is next.

Verify that the paths and options you have specified are accurate.
Click Back to go back to previous screens and correct any discrepancies.
Be aware that once you click Install, the installation process will begin to add files using the information you have specified.
Click Install to begin the installation process when you are ready.

10. The Installation Progress screen appears and displays files being installed. You can also verify progress by opening the RFDE_INSTALL.LOG file, which is created in the RF Design Environment install directory.

Once the installation is complete the final screen appears automatically.
11. The Installation Complete screen appears last. 
   Before you click Finish to exit the install program, take a look at the README file. This file contains last-minute information and resources to help you with licensing and starting RF Design Environment. 

12. When you are finished, click Finish to exit the installation wizard. 

13. Unmount the installation CD-ROM: 
   
   ```
   cd /
   umount /cdrom
   ```

   **Note** You must be in the root directory to unmount the CD-ROM. If you are running Solaris 7/8/9 and vold is active, you can type the following command to unmount the CD-ROM: `eject cdrom`.

14. Use the FLEXlm security codewords from Agilent EEsof to create a license.lic file with the correct SERVER and VENDOR line configurations. (Refer to Chapter 3, Setting Up Licenses.) 

15. Place the license.lic file in the licenses sub-directory of your RF Design Environment installation directory and start FLEXlm to enable your codewords. (Refer to Chapter 3, Setting Up Licenses.) 

   
   If you will be using license bundles, select a bundle using the Agilent License Preference Tool. (See “Using the Agilent License Preference Tool” on page 4-1.)
Installing RF Design Environment

**Configuring User Accounts**

Configure the user accounts that will run RF Design Environment as follows:

**C-Shell:**

Add the following at the end of `$HOME/.cshrc`:

- `setenv HPEESOF_DIR <install_directory>`
- `setenv AGILEESOFD_LICENSE_FILE <path_to_license_file>`
  
  Default: `$HPEESOF_DIR/licenses/license.lic`

- `setenv CLS_CDSD_COMPATIBILITY_LOCKING NO`
  
  Needed in most cases where you mix file systems.

- `setenv CDS_LIC_FILE <path_to_cadence_license_file>`
- `setenv CADENCE_DIR <path_to_cadence_install_directory>`
  
  This is the path to the modified Cadence installation directory or the shadow directory specified in the installation wizard's Collect Information 2/2 screen.

- `setenv PATH $CADENCE_DIR/tools/dfII/bin:$CADENCE_DIR/tools/bin:.:$PATH`
- `setenv PATH $HPEESOF_DIR/bin:.:$PATH`

**Bourne or Korn Shell:**

Add the following at the end of `$HOME/.profile`:

- `export HPEESOF_DIR=<install_directory>`
- `export AGILEESOFD_LICENSE_FILE=<path_to_license_file>`
  
  Default: `$HPEESOF_DIR/licenses/license.lic`

- `export CLS_CDSD_COMPATIBILITY_LOCKING=NO`
  
  Needed in most cases where you mix file systems.

- `export CDS_LIC_FILE=<path_to_cadence_license_file>`
- `export CADENCE_DIR=<path_to_cadence_install_directory>`
  
  This is the path to the modified Cadence installation directory or the shadow directory specified in the installation wizard's Collect Information 2/2 screen.

- `export PATH=..:$HPEESOF_DIR/bin:$PATH`
- `export PATH=$CADENCE_DIR/tools/dfII/bin:$CADENCE_DIR/tools/bin:$PATH`
Note If you are running Common Desktop Environment (CDE) or HP VUE, your user account may be using ${HOME}/.dtprofile or ${HOME}/.vueprofile respectively to set up your user account instead of .cshrc or .profile. The .dtprofile and .vueprofile files contain a line that can be uncommented to activate the use of .cshrc or .profile. Please see your system administrator or CDE or VUE documentation for details.

Once the user accounts are configured, each user should log in and verify that the new environment variables are set. Type the `env` command and check that HPEESOF_DIR and AGILEESOFD_LICENSE_FILE are set and that PATH contains a path to the RF Design Environment bin subdirectory.

**Setting Ownerships and Permissions**

If you installed RF Design Environment as root, set the ownership of directories and files, and verify file permissions:

- The ownership of directories and files will be set to user id 1313 and group id 22 after installation. To change this, enter the following commands:

  ```bash
  cd $HPEESOF_DIR
  chown -R root *
  chgrp -R sys *
  ```

- Verify that all RFDE files have at least read and execute permissions for all users.

**Setting the RFDE Product License Variable**

Note For RFDE 2003A, Agilent recommends using the License Preference Tool to select license bundles, and to not use the ADSPKG variable. See “Using the Agilent License Preference Tool” on page 4-1. The following information about ADSPKG is for reference only and should not be used in RFDE 2003A.

You must set the RF Design Environment system environment variable, ADSPKG, to identify and run the RFDE product you purchased. This setting will correspond to the codeword in your license file that you will set up later. For more information about
Installing RF Design Environment

codewords and license files, see Chapter 3, Setting Up Licenses. You can set ADSPKG to the value corresponding to your RFDE product:

<table>
<thead>
<tr>
<th>RFDE Product</th>
<th>ADSPKG Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>RFDE Wireless Pro</td>
<td>rfde_wireless</td>
</tr>
<tr>
<td>RFDE Wireline Pro</td>
<td>rfde_wireline</td>
</tr>
<tr>
<td>RFDE Premier</td>
<td>rfde_premier</td>
</tr>
<tr>
<td>RFDE Premier+</td>
<td>rfde_premier_plus</td>
</tr>
</tbody>
</table>

To set ADSPKG, do so in the shell environment using the appropriate value:

- For C-Shell, set ADSPKG in the file $HOME/.cshrc or enter the command:
  ```
  setenv ADSPKG <value>
  ```
- For Bourne or Korn Shell, set ADSPKG in the file $HOME/.profile or enter the command:
  ```
  export ADSPKG=<value>
  ```

**Note**  When setting the shell environment variable from the command line, be sure to set it in the same terminal window in which you will run RFDE, and set it prior to starting RFDE.

For remote simulations, if ADSPKG is set on the remote machine (such as, in .cshrc), then the RFDE license bundle that it points to will be used. If the RFDE license bundle specified by ADSPKG is not available, then the remote simulation will not run. If ADSPKG is not set in the remote environment, then the remote simulator will use separate simulation licenses for each simulator used in your simulation. If the appropriate licenses are not available, the simulation will not run.
Defining the RFDE Libraries

To run simulations in RF Design Environment using the ADSsim simulator, it is important to use components from the adsLib library, and the RFDE versions of the analogLib and basic libraries. These libraries are installed with RFDE in $HPEESOF_DIR/cdslibs, and they should be defined by the cds.lib file. A sample cds.lib file is also installed with RFDE in $HPEESOF_DIR/config. This file shows how to define the libraries for RFDE. The following lines are from the sample cds.lib file:

```
DEFINE adsLib $HPEESOF_DIR/cdslibs/adsLib
DEFINE analogLib $HPEESOF_DIR/cdslibs/$IDF_CDS_VERSION/analogLib
DEFINE basic $HPEESOF_DIR/cdslibs/$IDF_CDS_VERSION/basic
```

To set up your cds.lib file, choose one of the following options:

- If you have a cds.lib file in your startup directory, modify that existing file using the sample as a guide to define the RFDE libraries.

**Note**  To ensure RFDE uses the correct version of the analogLib and basic libraries, you must define only the RFDE versions of these libraries which are located in $HPEESOF_DIR/cdslibs. Also, set $IDF_CDS_VERSION to one of the following values corresponding to the Cadence version you are using with RFDE:

4.4.5
4.4.6
5.0.0

- If you don’t have a cds.lib file in your startup directory, copy the sample to your startup directory, and modify it as needed.
Installing RF Design Environment

Setting Proxies in Netscape

The help systems for RF Design Environment and Cadence interact with each other. The interaction requires a specific proxy setting in Netscape that ensures the help systems communicate properly. For details about Netscape requirements, see “Check the System Requirements” on page 1-3.

To check the Netscape proxy setting, and modify it if necessary:

1. Launch Netscape.
2. In the Netscape window, click Edit > Preferences.
3. In the left frame of the Preferences dialog box, expand the Advanced section, then click Proxies.
5. Click View.
6. In the field next to No Proxy for: enter the full hostname for your computer, including the domain. Contact your system administrator for details about your hostname and domain. Separate multiple proxy entries with commas.
7. Click OK to close the dialog boxes.
Changes in the Cadence Installation Directory

During the RF Design Environment installation, either the Cadence installation directory or the shadow directory is changed. $CADENCE_DIR$ is set to the directory path. (For information about defining $CADENCE_DIR$, see “Configuring User Accounts” on page 2-8.) Several files are copied to the directory and existing files are revised. The following list shows the RFDE files copied to the directory with their locations:

- $CADENCE_DIR$/local/doc/rfdecomponents/rfdecomponentsTOC.html
- $CADENCE_DIR$/local/doc/rfdeexamples/rfdeexamplesTOC.html
- $CADENCE_DIR$/local/doc/rfderfdeexamples/rfderfdeexamplesTOC.html
- $CADENCE_DIR$/local/doc/rfderfdeexamples/rfderfdeexamplesTOC.html
- $CADENCE_DIR$/local/doc/rfderfdeexamples/rfderfdeexamplesTOC.html
- $CADENCE_DIR$/local/doc/rfderfdeexamples/rfderfdeexamplesTOC.html
- $CADENCE_DIR$/local/doc/rfderfdeexamples/rfderfdeexamplesTOC.html
- $CADENCE_DIR$/local/doc/rfdesimulation/rfdesimulationTOC.html
- $CADENCE_DIR$/local/tools/dfII/etc/tools/ads/.cdsenv
- $CADENCE_DIR$/local/tools/dfII/etc/tools/adsDL/.cdsenv
- $CADENCE_DIR$/local/tools/dfII/etc/tools/ADSsim/.cdsenv
- $CADENCE_DIR$/local/tools/dfII/etc/tools/menus/ADSsim.menus
- $CADENCE_DIR$/local/tools/dfII/etc/skill/hnl/ads.ile
- $CADENCE_DIR$/local/tools/dfII/etc/skill/si/caplib/ads.ile
- $CADENCE_DIR$/share/cdssetup/hierEditor/templates/ads

**Note**  If any of the copied files already exist before installing RFDE, they will be backed up in the same directories with the extension .rfde.bak. Repeating the installation overwrites *.rfde.bak files in these directories. It is a good practice to back up all *.rfde.bak files manually before repeating the installation to avoid losing data you may need again.

The Cadence file $CADENCE_DIR$/tools/dfII/etc/tools/auCore/.cdsenv is modified to add ads to the Tool Filter’s list of simulators. The previous version of the file is saved as .cdsenv.rfde.bak in the same directory.
Installing RF Design Environment
Chapter 3: Setting Up Licenses

Use the following information to set up licenses for RF Design Environment on UNIX systems. After you install RF Design Environment using the steps described in Chapter 2, Installing RF Design Environment, you will need to set up the FLEXlm license manager and your RFDE license file (license.lic) before you can run RF Design Environment.

RF Design Environment uses Globetrotter Software's Flexible License Manager (FLEXlm) software for all software security configurations. When you run the RF Design Environment Setup program, the FLEXlm software is installed at <installation folder>/licenses/bin where <installation folder> is the destination folder you specified when you ran Setup.

**Important** When requesting licenses for HP-UX 11.x systems from Agilent, avoid keying licenses to the LAN ID/MAC address. Globetrotter does not recommend using an ethernet address for the hostid on HP-UX 11.x systems.

For details on using FLEXlm, refer to the Globetrotter website at:

http://www.globetrotter.com/
Installing Licenses

Each RFDE product requires a new, unique codeword. You must request and install your new codeword to run RFDE. To learn how to request codewords, see “Get Codeword for RF Design Environment” on page 1-5. Complete the steps in the following sections to install and configure your codeword in the license file.

Save License File

Edit License File

Place License File

Start License Server

Provide Access to Licenses

Will you use License Bundles?

Yes

Select License Bundle using Agilent License Preference Tool

No

Launch RF Design Environment
Save the License File

When you receive your codeword file from Agilent EEsof Business Support, it will be called license.lic. Save the license.lic file using the same filename. Most codewords are distributed by e-mail.

Edit the License File

Edit your license.lic file to correct the SERVER line and add information to the VENDOR line. Refer to “SERVER Line Guidelines” on page 3-7 and “VENDOR Line Guidelines” on page 3-8 for details. You can merge an RF Design Environment license file with an ADS license file. Instructions for doing this are included with the license file when you receive it. You can use the Agilent License Information Tool to check your environment variable settings, display your license.lic file, and show your license and server status. For details, refer to “Using the Agilent License Information Tool” on page 3-31.

Note Each line in the license.lic file must be a single continuous line with each field separated by a single space. You may line wrap lines using the backslash (\) character, but be very careful not to add a space after the backslash. Otherwise, you can remove the backslash and make each INCREMENT line one continuous line.
Setting Up Licenses

Node-Locked File

The codeword file must follow the format shown in the following example, which shows entries for each of the RFDE products. This example is from a node-locked file where the quantity, displayed on the first line after the date, is typically “1”:

SERVER unknown 80fb214d
VENDOR agileesofd
INCREMENT rfde_wireless agileesofd 2.3 01-jan-2003 1 \  
  VENDOR_STRING="80fb214d : JRDNSO IWSPGBB ICHLEDL JIWDLWB \  
  ICUNETS MCTENRX YGRTAKP SOG" HOSTID=00008645603e SIGN="029A 8798 \  
  C8B4 38B9 4EDE 6A8B 900B 7622 5F5E 264B EF01 FFEE 510D D037 \  
  D957 D872 B293 E956 E199 6F51 756E"
INCREMENT rfde_wireline agileesofd 2.3 01-jan-2003 1 \  
  VENDOR_STRING="80fb214d : JRDNSO IWSPGBB ICHLEDL JIWDLWB \  
  ICUNETS MCTENRX YGRTAKP SOG" HOSTID=00008645603e SIGN="01BD ADC0 \  
  046D 29BD 662F CDD4 8B74 09E0 965F 2C7A 6803 F3C9 41EF 88EC \  
  CEA3 7650 4F5F 85F7 9FD8 BB0C 324E"
INCREMENT rfde_premier agileesofd 2.3 01-jan-2003 1 \  
  VENDOR_STRING="80fb214d : JRDNSO IWSPGBB ICHLEDL JIWDLWB \  
  ICUNETS MCTENRX YGRTAKP SOG" HOSTID=00008645603e SIGN="02B9 A863 \  
  ED2B 6F62 6DAC 9DE2 OCAE 7BA1 9B55 4081 E600 8DE9 ACB1 7A5C \  
  0280 DC2A 176B C483 C160 0FAB 4408"
INCREMENT rfde_premier_plus agileesofd 2.3 01-jan-2003 1 \  
  VENDOR_STRING="80fb214d : JRDNSO IWSPGBB ICHLEDL JIWDLWB \  
  ICUNETS MCTENRX YGRTAKP SOG" HOSTID=00008645603e SIGN="0262 3F61 \  
  B799 E628 22DB D688 2B66 0F2E 300B AA72 AF02 AD46 BA6F A41B \  
  456C 6558 F6F9 714A 87F5 5DFA 1DB3"
Floating-License File

The codeword file for a floating license is the same as the previous node-locked file example, with two exceptions: There is no HOSTID identifier in a floating license and the quantity can be any number, one or more, depending upon the number of licenses you own. Below is a sample of a floating-license file containing entries for each RFDE product:

SERVER unknown 80fb214d
VENDOR agileesofd
INCREMENT rfde_wireless agileesofd 2.3 01-jan-2003 2 \ VENDOR_STRING="80fb214d : JRDMSO IWSPGBB ICHLEDL JIWDLWB \ ICUNETS MCTENRX YGRTAKP SOG" SIGN="029A 8798 CB44 38B9 4EDE \ 6AB2 900B 7622 5F5E 264B EF01 FFEE 510D D037 D957 D872 \ B293 E956 E199 6F51 756E"
INCREMENT rfde_line rfde_premier_plus agileesofd 2.3 01-jan-2003 2 \ VENDOR_STRING="80fb214d : JRDMSO IWSPGBB ICHLEDL JIWDLWB \ ICUNETS MCTENRX YGRTAKP SOG" SIGN="02B9 A863 ED2B 6F62 6DAC \ 9E27 0CAE 7BA1 9B55 4081 E600 BDE9 ACB1 7A5C 0280 DC2A \ 176B C4B3 C160 0FAB 4408"
Setting Up Licenses

**SERVER Line Format**

The SERVER line, by default, has the following format:

```
SERVER hostname hostid
```

where

- `hostname` is the network name of the machine whose `hostid` appears in field 3 of the SERVER line.
- `hostid` is the unique machine id of the license server machine.

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP-UX</td>
<td><code>/usr/bin/hostname</code></td>
</tr>
<tr>
<td>Solaris</td>
<td><code>/bin/hostname</code></td>
</tr>
</tbody>
</table>

 Optionally, a TCP port number may be specified on this line, for example:

```
SERVER hostname hostid tcp_port_number
```

- `tcp_port_number` is the TCP port number that the license server will listen at for license requests. An example of a TCP port number is 27000.
SERVER Line Guidelines

- Your license file should contain an odd number of SERVER lines; for example, 1 or 3. If you have 3 SERVER lines, the first SERVER is the primary license server and the other two are backup servers. All three SERVER lines must use the same tcp_port_number.

- You may only change the hostname and the optional tcp_port_number fields.

- Adding or removing SERVER lines requires a new license.lic file.

- By default, Agilent EEsof sets hostname to unknown. The SERVER line does not contain a port address. FLEXlm software assigns a port address in the range of 27000 to 27009. The examples in this manual use a port address of 27000, but your license file may differ. If you do not want to use the port address assigned by FLEXlm, specify any other unused port number for your network.

Note
Enter a specific port address on the SERVER line for improved license check-out performance. You may enter a port address outside the range of 27000 to 27009, as long as the address is not used elsewhere. Also, set the environment variable AGILEESOFD_LICENSE_FILE as described in “Place License File” on page 3-11.

- If the hostid is wrong, or changes for some reason, you will need to request a new license.lic file from Agilent EEsof.

Here are examples of properly configured SERVER lines:

SERVER joshua 2072EFE45 (default)

SERVER isaiah 20472A3D3 27000 (optional)
Setting Up Licenses

**VENDOR Line Format**

The VENDOR line, by default, has the following format:

```
VENDOR daemon_name
```

where

```
d daemon_name is the name of the vendor daemon.
```

Optionally, you may specify a path to the vendor daemon and a path to the FLEXlm options file, for example:

```
VENDOR agileesofd /my_install_dir/licenses/vendors/agileesofd
```

**VENDOR Line Guidelines**

- During installation of RF Design Environment, the vendor daemon is installed in the $HPEESOF_DIR/licenses/vendors and $HPEESOF_DIR/licenses/bin directories.
- The daemon_name must be agileesofd.
- The path to the options file is intentionally left blank. If you want to use FLEXlm options, you must add a full path to your option file. To learn about FLEXlm options, refer to the section "Using FLEXlm Options" on page 3-20. If the file does not exist and this option is not blank, a warning message will appear in the flex.log file.
- Here is an example of a properly configured VENDOR line (without an options file):

```
VENDOR agileesofd /my_install_dir/licenses/vendors/agileesofd
```
INCREMENT Line Format

The INCREMENT lines must have the following format:

INCREMENT feature vendord ver exp num vendorstring hostid sign

where

- feature is the name of the feature licensed by this line.
- vendord is the name of the vendor daemon that will manage this feature.
- ver is the version of the feature licensed by this line.
- exp is the expiration date of this license.
- num is the number of licenses this line enables.
- vendorstring is the CPU ID of the primary license server.
- hostid is an optional field. If this field exists, it is the hostid of the machine that this license is node-locked to. Only the machine whose hostid appears in this field may checkout this license.
- sign is the encrypted codeword.
INCREMENT Line Guidelines

- None of the fields on the INCREMENT lines are editable. Any change made to any of the fields on an INCREMENT line will make that feature invalid. The only valid edit of an INCREMENT line is to add a backslash (\') to line wrap the line. Be careful not to add an extra space between fields when using a backslash to line wrap an INCREMENT line.

- Here are two examples of valid INCREMENT lines.

  Floating license example:
  INCREMENT rfde_wireless agileesofd 2.3 01-jan-2003 2 \n  VENDOR_STRING="80fb214d : JRDNMSO IWSPGGBB ICHEDEL ICUNET S "
  MCTENRX YGRTAKP JIWDLWB SOG" SIGN="029A 8798 CB44 3B9 4EDE \n  6A88 900B 7622 5F5E 264B EF01 FFE 510D D037 D972 \n  B293 E956 E199 6F51 756E"

  Node-locked license example:
  INCREMENT rfde_wireline agileesofd 2.3 01-jan-2003 1 \n  VENDOR_STRING="80fb214d : JRDNMSO IWSPGGBB ICHEDEL \n  ICUNETS MCTENRX YGRTAKP JIWDLWB SOG" HOSTID=00008645603e \n  SIGN="01BD ADC0 048D 29BD 662F CDD4 8B74 09E0 965F 2C7A \n  6B03 F3C9 41EF 88EC CEA3 7650 4F5F 85F7 9FD8 BB0C 324E"

The backslash used to line wrap these two INCREMENT line examples is prefaced by a space and contains a carriage return immediately after it. The \' character is the absolute last character of the line it is on.
Place License File

A copy of the license.lic file must be placed on all SERVER machine(s) listed in the license.lic file.

License Placement Guidelines

- The recommended location for the license.lic file is:
  $HPEESOF_DIR/licenses/license.lic

- You might need root permission to copy the license.lic file into the RF Design Environment installation directory if RF Design Environment was installed by a user logged in as root.

- You can choose to locate the license.lic file someplace else on the SERVER machine(s). If you choose to do this, make sure that RF Design Environment users properly set AGILEESOFD_LICENSE_FILE.

- Make sure that the license.lic file has at least read permission for all users:

  cd $HPEESOF_DIR/licenses
  chmod 555 license.lic

  This command gives you read/executable permissions only.

- Place a copy of the $HPEESOF_DIR/license directory on all SERVER machines or custom install the FLEXlm license server on each machine.
Setting Up Licenses

Start the License Server (lmgrd)

Use the following procedure and guidelines to start the license server, lmgrd, on the
SERVER machine.

**Important** Be sure to use the following guidelines to update all existing license
servers with the latest version of the FLEXlm software (e.g., lmgrd and lmuutil). The
software is installed with RFDE 2003A. Using older versions may cause
license-encryption errors, invalid hostid results, and unsupported feature errors.

Verify that all multiple and redundant servers are updated including any license
administration scripts in use. Run lmuutil directly from the RFDE 2003A installation
location ($HPEESOF_DIR/licenses/bin) for information to help modify the scripts.

You will need to stop, then restart, the license server to make these updates.

**Guidelines for Starting lmgrd**

- You only need to run lmgrd on the SERVER machine(s).
- If the SERVER machine(s) has RF Design Environment installed on it, you will
  find the FLEXlm license manager daemon (lmgrd) in the
  $HPEESOF_DIR/licenses/bin directory. If the SERVER machine does not have
  RF Design Environment installed, you can copy the $HPEESOF_DIR/licenses
directory from the machine that has RF Design Environment installed.
- RF Design Environment installs version 8.2a of FLEXlm. Make sure you use
  the version 8.2a lmgrd and agileesofd supplied or a newer version of lmgrd. You
can determine the version of lmgrd and agileesofd by typing the following
commands:
  
  cd $HPEESOF_DIR/licenses/bin
  ./lmgrd -v
  cd $HPEESOF_DIR/licenses/vendors
  ./agileesofd -v

3-12 Installing Licenses
Note  HP-UX users must set the permissions on /dev/lan0 to read, write and execute for all users before attempting to start lmgrd. You must have root permissions to do this: chmod 777 /dev/lan0

To start lmgrd:

Change the directory to where lmgrd resides on the SERVER machine and execute lmgrd. For example:

    cd $HPEESOF_DIR/licenses/bin
    ./lmgrd -c ../license.lic > ../flex.log

The login executing lmgrd must have full permissions to the licenses/bin directory and at least write permissions to the directory specified for flex.log.

All error, warning and status messages will be redirected to the flex.log file. After starting lmgrd, wait approximately 30 seconds, then look at the contents of flex.log to see if there are any errors that need to be corrected.
Setting Up Licenses

To verify that the licenses are available:

Make sure that the flex.log file does not contain any errors, then run lmstat as follows:

```
cd $HPEESOF_DIR/licenses/bin
./lmutil lmstat -a -c ../license.lic | more
```

Or, you may launch the Agilent License Information Tool to do this. Refer to “Using the Agilent License Information Tool” on page 3-31 for more information.

If the licenses are available, you should see a listing similar to the following:

```
lmutil - Copyright (C) 1989-2001 Globetrotter Software, Inc.
Flexible License Manager status on Tue 2/20/02 07:39
License server status: 27000@joshua
  License files on joshua: /ads2002c/licenses/bin/../rfde2003a.lic:
    joshua: license server UP (MASTER) v8.2
Vendor daemon status (on joshua):
  agileesofd: UP v8.2
Feature usage info:
Users of ads_datadisplay: (Total of 3 licenses available)
Users of ads_drc: (Total of 3 licenses available)
Users of ads_encoder: (Total of 3 licenses available)
Users of rfde_premier_plus: (Total of 3 licenses available)
Users of rfde_wireless: (Total of 3 licenses available)
Users of rfde_wireline: (Total of 3 licenses available)
Users of sim_adapt_comp: (Total of 3 licenses available)
Users of sim_behav_synth: (Total of 3 licenses available)
Users of sim_convolution: (Total of 3 licenses available)
Users of sim_dfilter: (Total of 3 licenses available)
Users of sim_envelope: (Total of 3 licenses available)
```
Provide Access to Licenses

Before attempting to start RF Design Environment, you must configure each user's login environment to allow access to the licenses on the SERVER machine(s). To do this you need to configure the environment variable named AGILEESOFD_LICENSE_FILE in the user's .profile or .cshrc.

Note  The AGILEESOFD_LICENSE_FILE environment variable will override any LM_LICENSE_FILE settings you might have set up. If AGILEESOFD_LICENSE_FILE is not set, LM_LICENSE_FILE will be used.

For example:

C Shell:
setenv AGILEESOFD_LICENSE_FILE $HPEESOF_DIR/licenses/license.lic

Bourne/Korn Shell:
AGILEESOFD_LICENSE_FILE=$HPEESOF_DIR/licenses/license.lic
export AGILEESOFD_LICENSE_FILE

You can avoid the need to have a copy of the license.lic file directly on the machine running RF Design Environment by setting AGILEESOFD_LICENSE_FILE as follows:

AGILEESOFD_LICENSE_FILE=port@SERVER_hostname

where

port is the TCP port number from the SERVER line(s) of the license.lic file.

SERVER_hostname is the network name of a SERVER machine serving RF Design Environment licenses. This must be a name that the SERVER is known by on the network. You should be able to successfully ping this name from the machine that will run RF Design Environment.
Setting Up Licenses

Or, if your license server is set up to search for an available port, your AGILEESOFD_LICENSE_FILE should read:

AGILEESOFD_LICENSE_FILE=@SERVER_hostname

For example,

C Shell:

```bash
setenv AGILEESOFD_LICENSE_FILE 27000@joshua

or

setenv AGILEESOFD_LICENSE_FILE @joshua
```

Bourne/Korn Shell:

```bash
AGILEESOFD_LICENSE_FILE=27000@joshua
export AGILEESOFD_LICENSE_FILE

or

AGILEESOFD_LICENSE_FILE=@joshua
export AGILEESOFD_LICENSE_FILE
```

The syntax to access multiple license server is as follows.

C shell:

```bash
setenv AGILEESOFD_LICENSE_FILE 27000@server1:27000@server2:27000@server3
```

Bourne/Korn shell:

```bash
export AGILEESOFD_LICENSE_FILE=27000@server1:27000@server2:27000@server3
```

However, in this case, “server” should be replaced by the actual license server name or IP address, and the “27000” may need to be changed to the actual port number on the license server. Note that the list of servers is separated by colons (:). For details on running FLEXlm-licensed products from multiple vendors refer to “Merging Multiple Vendor Licenses” on page 3-23.
Using a UNIX-to-PC Floating License

A PC system can access the UNIX license server's license.lic file in either of two ways:

- By copying the license.lic file from the UNIX license server to the PC’s $HPEESOF_DIR/licenses folder
- By setting the AGILEESOFD_LICENSE_FILE variable on the PC to point to the UNIX license server as follows:

  set AGILEESOFD_LICENSE_FILE=<port>@<host>

  For example:

  set AGILEESOFD_LICENSE_FILE=27000@joshua

  where

  27000 is the port number on the SERVER line in the license.lic file on the UNIX license server
  joshua is the hostname of the UNIX license server

Conversely, the license server can be a PC with a floating license locked to a LAN card or dongle hardware key and the UNIX computer can be set to point to it in the same way by using its host name or IP address.

Automating FLEXlm License Manager Startup

You can automate the FLEXlm startup so that lmgrd is started automatically each time the license server machine is rebooted by adding the following three lines for a startup routine to the appropriate rc file for your operating system:

```
/ads/licenses/bin/lmgrd -c /ads/licenses/license.lic >
/ads/licenses/flex.log &
echo "Starting Agilent EEsof FLEXlm license daemon......."
/usr/bin/sleep 5
```

**Note**   Be sure to change all references to /ads to the actual path of your Agilent EEsof software installation directory.

Following are separate instructions for the supported operating systems.
Setting Up Licenses

**HP UX Operating System**

2. Create a file in this directory named `Sagileesofd`.

   **Note** The S is capitalized. All other letters are in lower-case.

3. Place the FLEXIm startup routine (shown above) into this file.
4. Set the permissions for this file as follows:
   
   ```
   chmod 755 Sagileesofd
   chown root Sagileesofd
   chgrp sys Sagileesofd
   ```

**Solaris Operating Systems**

1. Change to the `/etc/rc3.d` directory.
2. Create a file in this directory called `Sagileesofd`.

   **Note** The S is capitalized. All other letters are in lower-case.

3. Place the FLEXIm startup routine (shown above) into this file.
4. Set the permissions for this file as follows:
   
   ```
   chmod 755 Sagileesofd
   chown root Sagileesofd
   chgrp sys Sagileesofd
   ```
Selecting a License Bundle

This step is necessary only if you are using license bundles.

If you have been using license packages in previous versions, you should be aware that packages have been replaced by license bundles in RFDE 2003A. You must select a bundle using the Agilent License Preference Tool when starting RFDE to ensure a license bundle is being used. Bundles are an improvement over packages by giving you more control over which license bundles are used during an RFDE session. To learn how to select bundles using the preference tool, see “Using the Agilent License Preference Tool” on page 4-1.
Special Licensing Needs

Use the following information to accommodate any special licensing needs you may have. For details on using FLEXlm, refer to the Globetrotter website at:

http://www.globetrotter.com/flexlm

Using FLEXlm Options

An options file enables the license administrator to control the security parameters of FLEXlm. Specifically the license administrator can:

- Allow the use of features based on user, hostname or display name.
- Deny the user of features based on user, hostname or display name.
- Reserve licenses based on user, hostname or display name.
- Control the amount of information logged about license usage.

Creating an Options File

Use the desired options listed to create the options file using any text editor. Ideally, you should keep the options file in the same directory as your license.lic file. Also, add the pathname to the options file in the license.lic file as the fourth field on the VENDOR line for agileesofd as shown in the following example. (Remember to use the backslash ('\') character if the file contains wrapped lines):

```
VENDOR agileesofd /<install_dir>/licenses/vendors/agileesofd \
 /<install_dir>/licenses/agileesofd.opt
```

You can include comments in your options file by starting each comment with a pound sign ('#'). Everything in the options file is case-sensitive. Be sure that user names and feature names, for example, are entered correctly. The available options are:

- **EXCLUDE**
  Deny a user access to a feature.

- **EXCLUDEALL**
  Deny a user access to all feature served by this vendor daemon.

- **GROUP**
  Define a group of users for use with any options.
• INCLUDE
  Allow a user to use a feature.

• INCLUDEALL
  Allow a user to use all features served by this vendor daemon.

• NOLOG
  Turn off logging certain items.

• REPORTLOG
  Specify that a logfile be written suitable for use by the FLEXadmin End-User Administration Tool.

• RESERVE
  Reserve licenses for an individual user or groups of users.

• TIMEOUT
  Works only for specified simulator and library licenses.

• TIMEOUTALL
  Works for all simulator and library licenses.

Use the following steps to create and use an options file. Details about each step located in “Installing Licenses” on page 3-2:

1. Create an options file with your required options.
2. Modify your license.lic file so that the VENDOR or DAEMON line points to this option file as shown in this example:

```
VENDOR agileesofd /<install_dir>/licenses/vendors/agileesofd 
/<install_dir>/licenses/agileesofd.opt
```

3. Start up your license server (lmgrd) that is pointing to your license file. You must stop it first if it is running. It’s important that a message is displayed or recorded in the FLEXlm log verifying the license manager is using the options file. The following example shows that the license manager is using the agileesofd.opt file containing the TIMEOUTALL option set to 900 seconds:

```
17:35:14 (agileesofd) Using options file:
"/<install_dir>/licenses/agileesofd.opt"
```

```
17:35:15 (agileesofd) ALL FEATURES: INACTIVITY TIMEOUT set to 900 seconds
```

4. Set AGILEESOFD_LICENSE_FILE to point to your license server.
5. Run RFDE.
Specifying the TIMEOUT Option

You can set a custom time-out period for simulator and library licenses using the TIMEOUT or TIMEOUTALL options. If you do not specify a time-out value in your options file or do not have an options file, a default two-hour limit is used. These time-out options apply to those application features that have explicitly implemented time-out via the heartbeat function. This includes licenses for the ADSim simulator and for the adsLib library. The time-out options do not affect licenses for other RFDE features such as the data display. The time-out option sets the amount of time a feature may remain idle before its license is released and reclaimed by the vendor daemon. The TIMEOUT option enables you to identify specific licenses, and the TIMEOUTALL affects all licenses (simulator and library).

To use TIMEOUT, add an entry for each feature to the options file using the following format:

```
TIMEOUT feature_name seconds
```

where:

- `feature_name` is name of the feature.
- `seconds` is the number of seconds before inactive license is reclaimed. The minimum value is 900 seconds (15 minutes). If you specify a time-out value smaller than the minimum, the minimum is used.

The option TIMEOUTALL works just like TIMEOUT, but applies to all features.

```
TIMEOUTALL seconds
```

Here are example entries you can include in your options file:

- To set a time-out for the harmonic balance to one hour (3600 seconds):
  ```
  TIMEOUT sim_harmonic 3600
  ```
- To set time-outs for multiple simulation features to different periods:
  ```
  TIMEOUT sim_linear 900
  TIMEOUT sim_harmonic 3600
  ```
- To set a time-out for all simulation and library features to one hour (3600 seconds):
  ```
  TIMEOUTALL 3600
  ```
 Updating the License File

If you have been running FLEXlm and receive updated codewords from Agilent EEsof, you can add the new licenses to the FLEXlm environment as follows:

1. Replace the existing licenseslic files on the license servers and clients with the new licenseslic file.

2. On the primary server, run `lmutil lmreread`. This causes the lmgrd on the primary server to re-read the licenseslic file and update all of the other lmgrd processes on the network.

3. After you have done this, you can run `lmutil lmstat -a` to verify that the license servers have received the new license information.

If this does not work, you may need to stop all of the lmgrd processes on your network and then restart them as described in the section “Installing Licenses” on page 3-2.

 Merging Multiple Vendor Licenses

When you are running FLEXlm-licensed products from multiple vendors, you have three ways to prevent licensing conflicts during installation:

- Multiple license server nodes; each running one lmgrd and one license file
- One license server node running one lmgrd and one license file
- One license server node running multiple lmgrds and multiple license files

Each lmgrd can only read a single license file. With the first option you will have more license servers to monitor. With the third option you have only one server but multiple lmgrds to administer.

Your product's license file(s) define the license server(s) by hostname and hostid in the SERVER line(s) in the license file.

- If the license files for two or more products contain identical hostids on the SERVER line(s), then these files can be combined.

- If the license files for two products contain different hostids on a SERVER line, then the license servers for those products will be running on different nodes and the license files cannot be combined.
Setting Up Licenses

If you have two or more products whose license servers run on the same node (as specified by the SERVER lines in the license files), you may be able to combine the license files into a single license file.

- If the SERVER lines in those files have identical hostids, then you can combine the files into a single file.
- If the SERVER lines have different hostids, then you must keep the license files separate.

More precisely, you can combine two license files under the following conditions:

1. The number of SERVER lines in each file is the same.
2. The hostid field of each SERVER line in one file exactly matches the hostid field of each SERVER line in the other file.

Some possible reasons license files may not be compatible are:

- License files are set up to run on different server nodes, so hostids are different.
- One file is set up for single server (has only one SERVER line), the other is set up for redundant servers (has multiple SERVER lines).
- One vendor uses a custom hostid algorithm, so the hostids on the SERVER lines are different even though the files are for the same machine.

If your license files are compatible as described above, then you can combine license files and run a single lmgrd, as described in “Combining License Files from Multiple Vendors” on page 3-25. If the license files are not compatible, then you must keep the license files separate and run separate copies of lmgrd for each license file, as described in the section, “Using Separate License Files on the Same Server Node” on page 3-26.

**Important** There is virtually no performance or system-load penalty for running separate lmgrd processes.
Combining License Files from Multiple Vendors

If your license files are compatible, you can combine them using any text editor. To combine license files, merge all of the compatible license files into one file, then edit out the extra SERVER lines so that only one set of SERVER lines remains. Write out this data, and you have your combined license file.

If you combine license files from multiple vendors, it is a good idea to keep a copy of the combined license file in each vendor's default license file location. This way, your users can avoid having to set AGILEESOFD_LICENSE_FILE, because each package finds its license information in the default place. On UNIX, you can do this with a symbolic link from each default location to the location of the combined license file.

FLEXlm Version Component Compatibility

When you combine license files for two different FLEXlm-licensed products, the products may not use the same version of FLEXlm. FLEXlm is designed to handle this situation. There are two basic compatibility rules for FLEXlm:

1. A newer lmgrd can be used with an older vendor daemon, but a newer vendor daemon might not work properly with an older lmgrd.
2. A newer vendor daemon (or lmgrd) can be used with an older client program, but a newer client program might not work properly with an older vendor daemon.

From these two compatibility rules come the simple rules for selecting which version of administration tools to use:

1. Always use the newest version of lmgrd and the newest version of each vendor daemon.
2. Use the newest FLEXlm utilities.

For specific application programs, you can use either the new or the old version (with the assumption that the vendor daemon for that application is at least as new as the application).
Setting Up Licenses

**Using Separate License Files on the Same Server Node**

You must run a separate copy of lmgrd for each license file. When you run multiple copies of lmgrd, there are two details to remember:

1. The port number on the SERVER line of each license file must be unique. You can use a standard text editor to change the port number in each license file so that they are all different.

2. You must make sure that you are using a compatible version of lmgrd when you start it up for a particular license file. This can be done by using an explicit path to lmgrd.

When running client programs (such as a licensed application), you can set the `AGILEESOFD_LICENSE_FILE` environment variable to point to multiple license files. For example, you may have a license file from vendor ABC and a license file from vendor XYZ with incompatible servers. You can place the license file from vendor ABC into:

```
/user/flexlm/abc.lic
```

and the license file from vendor XYZ into:

```
/user/flexlm/xyz.lic
```

then set the `AGILEESOFD_LICENSE_FILE` environment variable to point to both of them. The syntax is as follows:

```
AGILEESOFD_LICENSE_FILE=27000@server1;27000@server2;27000@server3
```

Note that each path is separated with a semi-colon.

`AGILEESOFD_LICENSE_FILE` can point to only one license file for FLEXlm v1.x applications.
Redundant License Servers

You can set up a redundant or backup license server(s), in case a primary server is unavailable. If your license.lic file has the maximum number of SERVER lines (three), you have a redundant license server configuration. The license setup is identical to a single SERVER configuration, with the exception that no licenses will be available until a majority of the license servers are running. That is, if you have three SERVER lines, at least two must be up and running before any licenses will be available for checkout. Be sure that the FLEXlm software is loaded and running on each server.

Note: If you have more than one SERVER line in the license.lic file, you must start lmgrd on all the SERVER machines to enable the licenses.

Controlling License Path Settings

The lmutil utility provides the lmpath function which allows direct control over FLEXlm license path settings. You can use lmpath to add to, override, or get the current license path set in the registry. This enables you to change or view path settings without locating individual settings in the Windows registry on the PC or in the FLEXlm registry (.flexlmrc) on UNIX.

The lmutil utility is located in $HPEESOF_DIR/licenses/bin. This location must be in your PATH, or use the following command before running the utility:

```
cd $HPEESOF_DIR/licenses/bin
```

The usage for this function is:

```
lmutil lmpath {status | -add | -override} {vendor_name | all} license_path_list
```

where

- **status** displays the current license path settings.
- **add** appends license_path_list to the front of the current license-path settings or creates the list of license-path settings, if it doesn't exist, initializing it to license_path_list. Duplicates are discarded.
- **override** overrides the existing list of license-path settings with the contents of license_path_list. If license_path_list is the null string, "", the specified list is deleted. For example:
Setting Up Licenses

```bash
lmutil lmpath -override agileesofd ""
Deletes the value of AGILEESOFD_LICENSE_FILE from the registry.

lmutil lmpath -override vendor2 ""
Deletes the value of VENDOR2_LICENSE_FILE from the registry.

lmutil lmpath -override all ""
Deletes the value of LM_LICENSE_FILE from the registry.
```

*vendor* is a string naming a particular vendor daemon name. Affects the value of *vendor* _LICENSE_FILE_. For example, use *agileesofd* to affect AGILEESOFD_LICENSE_FILE.

*all* refers to all vendor daemons. Affects the value of only LM_LICENSE_FILE.

*license_path_list* is the new path setting(s). On UNIX, this is a colon-separated list, and on Windows it is a semi-colon-separated list. If *license_path_list* is the null string, "", then the list is deleted for the specified vendor. Though you can enter specific license file names, you gain flexibility by entering only a path without a file name. This will include all *.lic* files in the same location.

---

**Note**  Environment variable settings (set in your shell) always override these registry settings.
Checking the Status

Before you change license path settings, Agilent recommends that you display the current settings. To display the settings, enter the following commands:

```
lmutil lmpath -status
```

The following example status listing is from UNIX and is similar to a PC listing:

```
lmpath - Copyright (C) 1989-2002 Globetrotter Software, Inc.
Known Vendors:

agileesofd: /ads2002c/licenses/license.lic:/ads2003a/licenses/license.lic
cds1md: /cadence/cdsdir5.0.0/share/license/license.dat:9999@host

Other Vendors:

/usr/local/flexlm/licenses/license.lic
```

Note Where a path is set to a directory, each of the *.lic files are listed separately.
Setting Up Licenses

**Changing License Path Settings**

When adding or overriding path settings, lmpath sets the FLEXlm entry in the Windows registry on the PC, or changes the file $HOME/.flexlmrc on UNIX. Here are examples of how license settings may appear in each registry:

**UNIX:**

```
AGILEESOFD_LICENSE_FILE = /ads2002c/licenses:/ads2003a/licenses
CDSLMD_LICENSE_FILE = /cadence/cdsdir5.0.0/share/license/license.dat
```

**Windows:**

Registry location:
```
My Computer\HKEY_LOCAL_MACHINE\Software\Agilent\ADS2003A
```

Registry license path setting:
```
AGILEESOFD_LICENSE_FILE REG_SZ C:\ADS2003A\licenses
```

To change license path settings, enter the appropriate command in a Command Prompt on Windows, or a terminal window on UNIX. You can adapt the following examples which change path settings for AGILEESOFD_LICENSE_FILE:

- To add path settings on UNIX:
  ```
  lmutil lmpath -add agileesofd <new_lic_path1>:<new_lic_path2>
  ```

- To add path settings on Windows:
  ```
  lmutil lmpath -add agileesofd C:\<new_lic_path1>;C:\<new_lic_path2>
  ```

- To replace the current path settings on UNIX:
  ```
  lmutil lmpath -override agileesofd <new_lic_path>
  ```

- To replace the current path settings on Windows:
  ```
  lmutil lmpath -override agileesofd C:\<new_lic_path>
  ```
Using the Agilent License Information Tool

The Agilent License Information Tool is available to check your environment variable settings, display your license.lic file, and show your license and server status.

To run this tool, type the following line in the terminal window:

```
<installation directory>/bin/aglmtool
```

and press Enter to display the following window:

![Agilent License Information Information](image)

- **AGILENSET_LICENSE_FILE**
- **Computer/Hostname**
- **DISPLAY**
- **Default Hostid**
- **Domain**
- **Ethernet Address**
- **HOME**
- **KRB5ROF_DIR**
- **IP Address**
- **LM_LICENSE_FILE**
- **LOGNAME**
- **PATH**
- **SHELL**
- **TERM**
- **Username**
Setting Up Licenses
Chapter 4: Using RF Design Environment

To get you started using RF Design Environment, this section includes some basics along with useful tips for resolving problems that might occur after you have installed RF Design Environment.

Running RF Design Environment

Environment variables must be set, and the cds.lib file must define the correct component libraries before you can run RF Design Environment. To set the environment variables, see “Configuring User Accounts” on page 2-8. To set up your cds.lib file, see “Defining the RFDE Libraries” on page 2-11.

Your FLEXlm license file also must be properly configured and installed before you can run RF Design Environment. To set up your license file, follow the instructions in Chapter 3, Setting Up Licenses.

To run RF Design Environment, open a terminal window and type `rfde`. Open a schematic and the Analog Design Environment. Choose the ADSsim simulator. After ADSsim is loaded, use the Analog Design Environment’s Help menu to open the RF Design Environment documentation:

Choose Help > RF Design Environment Documentation > Quick Start for help on getting started with RF Design Environment.

Using the Agilent License Preference Tool

Note This section applies only to customers who have purchased license bundles. License bundles have replaced license packages in RFDE 2003A. You must select a license bundle when starting RFDE, and the License Preference Tool is a convenient way to make a selection.

If you have been using license packages in previous versions, you should be aware that packages have been replaced by license bundles in RFDE 2003A. A bundle looks like any other INCREMENT line in the license.lic file, but RFDE recognizes the feature name as a collection, or bundle, of individual features. When RFDE checks out the license bundle, it enables all the functionality associated with the individual features. You must select a license bundle using the Agilent License Preference Tool.
prior to running RFDE. This sets the environment variable AGILEESOFD_LICPREF_<hostname>. Since you cannot check out more than one bundle, you have more control over which license bundles are used during an RFDE session.

**Notes**  In RFDE 2002C, the ADSPKG variable was used to identify the product license. For RFDE 2003A, Agilent recommends using the License Preference Tool to control license bundle checkout. When both environment variables are set AGILEESOFD_LICPREF_<hostname> will take precedence over the ADSPKG.

Also, you only need to run the License Preference Tool when you want to change the latest bundle selection.

**To run the License Preference Tool:**

There are two ways to start the License Preference Tool. In a terminal window:

- When starting RFDE, enter `rfde -p`
  
  This runs the License Preference Tool, then runs RFDE after you finish choosing bundles.

- To run the tool as a standalone utility, enter `$HPEESOF_DIR/bin/aglmpref`
  
  This only runs the License Preference Tool.
The License Preference window appears similar to the figures below (Figure 4-1 and Figure 4-2). It enables you to view the available bundles and their features, and select bundles.

- To see the features available in a bundle, click the expansion icon next to the bundle name under Available License Bundles.
- To select a bundle, choose one of the bundles listed under Available License Bundles, then click Add. The selected bundle appears under Selected License Bundles.
- To accept your choice, click OK. This sets the environment variable AGILEE$OFD_LICPREF_<hostname> in $HOME/.flexlmrc.

**Note** You must have write permissions to update this file.

---

![Image of Agilent License Preference Tool](image)

Figure 4-1. Agilent License Preference Tool Showing rfde_premier Bundle Selected From Available Bundles
Using RF Design Environment

Figure 4-2. Agilent License Preference Tool Showing Features Available in the rfde_premier_plus Bundle

How the License Preference Tool Works

- When you run the License Preference Tool, it attempts to locate a license file using the following license definitions:
  - Environment variable AGILEESOFD_LICENSE_FILE
  - $HPEESOF_DIR/licenses/license.lic
  - aglmtool -c <port_address>@<hostname> (an example port address is 27000)
- The License Preference Tool will show all possible bundles if a license file is not located.
- You can select a bundle according to specific rules controlled by the License Preference Tool. See “Bundle-Selection Rules” on page 4-5.
- RFDE will start when a bundle is selected, and RFDE will not use a license bundle unless it is selected using the License Preference Tool.
• If, while using RFDE, the feature you attempt to use is not in the currently selected bundle, RFDE will attempt to check out a valid floating or nodelocked license for the feature. This is known as license roll-over. If license roll-over fails to check out a license, a license error will appear even if another bundle with the requested feature is available.

You can then select another bundle that contains the feature. Save your work, and exit RFDE. Then run the License Preference Tool to remove and add bundles, and restart RFDE.

**Bundle-Selection Rules**

The License Preference Tool controls bundle selection using the following rules:

• Each of the RFDE bundles contain a license for Cadence. Only the rfde_premier_plus bundle also contains the Advanced Design System’s design environment codeword (ads_schematic) enabling you to run ADS. You must select an RFDE bundle for a license preference to take place.

• Only one RFDE bundle can be selected at a time.

• If ADS license bundles are also available (ltp_xxxx or pl_xxxx), you can select them under these conditions:
  • If you have selected rfde_wireless, rfde_wireline, or rfde_premier, you can also select one of the LTP bundles (ltp_xxxx).
  • If you have selected rfde_premier, you can select the PL bundle (pl_xxxx).
  • If you select the rfde_premier_plus bundle, you cannot select any additional bundles.

Here are specific rules controlling the selection of ADS license bundles if they are available on your system:
Using RF Design Environment

If you are using Limited Term Package (LTP) Bundles

- LTP bundles (except ltp_design_guides) contain the design environment codeword (ads_schematic) enabling ADS to run. You must select an LTP bundle for a license preference to take place.
- If any PL bundles are available on your system, they cannot be selected with an LTP bundle.
- After selecting an LTP bundle, you cannot select any additional bundles except for the following conditions:
  - The ltp_design_guides bundle (if available) can be selected with another LTP bundle.
  - If ADS and RF Design Environment are installed on the same system, one of the following RFDE bundles (if available) can be selected with another LTP bundle: rfde_wireless, rfde_wireline, rfde_premier.

If you are using Pay-Per-Use License (PL) Bundles

- The pl_desenv bundle contains the design environment codeword (ads_schematic) enabling ADS to run. Other PL bundles appearing under pl_desenv are not selectable. You must select the PL bundle for a license preference to take place.
- If any LTP bundles are available on your system, they cannot be selected with the PL bundle.
- After selecting a PL bundle, you cannot select any additional bundles except for the following conditions:
  - The pl_design_guides bundle (if available) can be selected with the PL bundle.
  - If ADS and RF Design Environment are installed on the same system, only the rfde_premier bundle (if available) can be selected with the PL bundle.
Using a Custom Startup Script

The startup script (rfde) that you use to run RF Design Environment executes several commands. One of the commands sources the script $HPEESOF_DIR/bin/bootscript.sh. This script sets the shared libraries that RFDE uses. If you want to use a custom startup script to run RFDE, you must be sure to source bootscript.sh before attempting to run RFDE. You can source the script using one of the following commands in your startup script:

Note   The commands to source bootscript.sh are necessary only if SHLIB_PATH for HP-UX, or LD_LIBRARY_PATH for Solaris does not include the shared libraries required to run RFDE.

• If using the Korn shell
  . $HPEESOF_DIR/bin/bootscript.sh
• If using the C shell
  sh; . $HPEESOF_DIR/bin/bootscript.sh

If RF Design Environment Does Not Start

It is possible to install programs or options for which you have not purchased licenses. Although the icons and features will appear in the software, you cannot access the applications without a license. Contact your Agilent EEsol sales representative to obtain additional licenses.

If your RF Design Environment applications will not start:

• Make sure all of your licensing requirements are correctly set up, as explained in Chapter 3, Setting Up Licenses.

• Using a text editor open and review the install.log file in your installation folder to see if there are any apparent problems with the installation structure. (You can re-run Setup if necessary to re-install.)

• Try using the Agilent License Information Tool, which is available to check your environment variable settings, display your license.lic file, and show your license and server status. Refer to “Using the Agilent License Information Tool” on page 3-31 in Chapter 3, Setting Up Licenses.
Using RF Design Environment

Using RFDE with Multiple Versions of Cadence

RF Design Environment includes the script $HPEESOF_DIR/bin/rfdeShadow.sh that enables you to set up RFDE to run with multiple versions of Cadence without reinstalling the entire RFDE product. The script creates an RFDE-enabled Cadence shadow, or an RFDE-enabled Cadence (not a shadow) depending on the arguments you use with the script. You must have already installed the RF Design Environment once, and set HPEESOF_DIR (see Chapter 2, Installing RF Design Environment).

The complete syntax for rfdeShadow.sh is:

```
rfdeShadow.sh --cdsDir /<path_to_cds> [--shadowDir /<path_to_cdsShadow>] [--arch <arch_name>]
```

where

- **cdsDir** defines the directory where Cadence is installed.
- **shadowDir** defines the directory where Cadence will be shadowed.
- **arch** sets up an RFDE-enabled Cadence shadow for an operating system other than the one you are currently using. Allowed values are `sun4v`, `hppa`.

The following examples show how to use the script:

- To create a Cadence shadow and install RFDE files into the shadow for the current operating system:
  ```
  rfdeShadow.sh --cdsDir /<path_to_cds> --shadowDir /<path_to_cdsShadow>
  ```
- To install RFDE files directly into Cadence (no shadowing):
  ```
  rfdeShadow.sh --cdsDir /<path_to_cds>
  ```
- To obtain usage information, run the program without any arguments:
  ```
  rfdeShadow.sh
  ```

**Important** The script named rfdeShadow.pl is also located in $HPEESOF_DIR/bin. Do not run rfdeShadow.pl directly or an error will occur.
Printing and Plotting

RF Design Environment uses Xprinter for all Postscript, HPGL2 and PCL printing from the Data Display. For a complete list of output devices supported with Xprinter, consult the HTML file called Supported_Printers_XPV331.html, in <installation directory>/xprinter. This file lists the supported printers and also has a link to the Bristol website for the latest printer drivers. Your printer manufacturer’s website is also a good source for the latest printer driver software.

Printing From UNIX

Printing and plotting from the Data Display window in RF Design Environment is accomplished by establishing the desired print setup and then choosing File > Print. The following information assumes you have already set up and configured your system for printing.

Adding a Printer

Use the following steps to add a printer. You will need to define a port and then associate a printer with that port. You will need read and write permissions for your $HOME/.XprinterDefaults file.

To define a port and add a printer:
Using RF Design Environment

1. Choose **File > Print Setup** to open the Print Setup dialog box.

![Print Setup dialog box]

2. Click **Install** to open the Printer Installation dialog box with a list of all currently installed printers.

![Printer Installation dialog box]
3. Click **Add Printer** to open the Add Printer dialog box that lists all available printer devices and all currently defined ports.

If the printer you want to use doesn’t have a driver listed, use one of the following options:

- Select the closest match in the list based on the class/type of printer.
- Download a driver from the manufacturer’s website. If the website doesn’t have a UNIX driver listed, try the PC (Windows) driver. After you download the .ppd file, save it to the `$HPEESOF_DIR/xprinter/ppd` directory as a .ps (PostScript) file, that is, with a .ps extension.
- Select the generic postscript printer option from the “Printer Devices” list and then select a port definition.
4. Click **Define New Port** to display the Ports dialog box with a list of all currently defined ports.

5. Add the port(s) you want to access for printing:
   - On HP 700 and Sun Solaris workstations, click **Spooler** and the list of ports is automatically generated (based on your printcap file).
   - On all other workstations, type the port definition in the Edit Port field using the following syntax: `printer name=print command`, where `print command` is the print alias, just as you would type it in the terminal window. Click **Add-Replace**. Repeat for each desired port.

   **Note**  Port names can be any names you choose with the exception of **FILE**: which is a reserved port name.

6. Click **Dismiss** to accept the new port definitions and return to the Add Printer dialog box with its updated Current Port Definitions list.
7. Select the desired printer from the list of Printer Devices.

8. Select the port you want to associate with this printer.

9. Click **Add Selected** to update the Currently Installed Printers list in the Printer Installation dialog box.

10. **Dismiss** the Add Printer and Printer Installation dialog boxes. You will now be able to select any of the installed printers, as needed.
Using RF Design Environment

Common Licensing Problems

Following are solutions to common problems that occur regarding the FLEXlm licensing setup for RF Design Environment.

For details on using FLEXlm and lmtools, refer to the Globetrotter website at:

http://www.globetrotter.com/

Where to Begin

If you are having trouble getting FLEXlm working, the best place to begin troubleshooting is the flex.log file. The flex.log file is typically located in $HPEESOF_DIR/licenses.

Read the flex.log file and look for error or warning messages.

If nothing shows up in the flex.log file, try setting the following environment variable, then start RF Design Environment:

C Shell (/bin/csh)

    setenv HPEESOF_DEBUG_MODE key

Bourne/Korn Shell (/bin/sh, /bin/ksh)

    HPEESOF_DEBUG_MODE=key
    export HPEESOF_DEBUG_MODE

Look for errors or warnings in the shell where you started RF Design Environment.
Common Errors and Solutions

Following are possible solutions to certain license-related error messages that occur.

**RFDE Does Not Run After Starting the License Server**

If the following error message appears when you run RFDE, additional license configuration may be needed:

No such feature exists
Feature: rfde_premier
License path: $HPEESOF_DIR/licenses/license.lic;$HPEESOF_DIR/licenses/licenses.dat
FLEXlm error: -5,357

This error can appear if your license.lic file contains license bundles and you have not run the License Preference Tool to select a license bundle. You must select a license bundle using the License Preference Tool, so RFDE will know to use it.

**Inconsistent Encryption Code**

This error occurs when the information on the INCREMENT lines in thelicense.lic file is corrupted. Check the license.lic file for the following:

1. Make sure that each line of the license.lic file is a single continuous line with each field separated by a single space.

2. If there are backslash characters (\) line wrapping the lines, make sure that the backslash character is the absolute last character on its line. Even a space after the \ will cause a problem.

3. Try removing the backslash characters and joining the INCREMENT lines, so that each INCREMENT line is a single continuous line with no line wrap.

4. If the license.lic file was transferred from DOS to UNIX, make sure to remove the control M's (^M) at the end of all the lines in the license.lic file. If spaces are added to the end of each line to eliminate the ^M's, the spaces must also be removed. The spaces turn out to be just as disruptive as the ^M's. The best way to remove the ^M's is using the vi editor and the following substitution command:

   :1,$ s/.$//g

5. Make sure that none of the original SERVER line hostid information has been changed. Make sure that none of the SERVER lines have been eliminated.
Using RF Design Environment

Invalid Host or Unable to Determine Machine ID

This can be caused by one of the following:

1. Make sure that the information on the SERVER line(s) in license.lic is correct.

2. If the licenses are node-locked, and you attempt to run RF Design Environment on a machine other than the machine the licenses are node-locked to, you will get a license error indicating invalid host. To check if this is the case, look at the $HPEESOF_DIR/licenses/license.lic file and check the INCREMENT lines. If each INCREMENT line ends in a machine hostid, then the licenses are node-locked to the machine whose id is shown. You can, however, export the display from the node-locked machine to another display.

3. If you are on an HP workstation, check the permissions of the /dev/lan0 file. This file must have read and write permissions for all:

   chmod 777 /dev/lan0

   The FLEXlm lmgrd and agileosf vendor daemons use this file and must be able to read and write to this device.
Invalid System Clock Time

FLEXlm detects when systems have had their dates set more than 24 hours back, and prevents users from using expired licenses by setting the clock back. It works by looking for any files in “/” or “/etc” that have a date more than 24 hours in the future.

Use the command ls -lat in “/” and “/etc” to find the offending file(s). The date of the offending file(s) can be corrected by using the touch command:

```bash
touch <filename>
```

If the file is a link, the link must be removed and then recreated. If the link itself is dated ok, check the date of the actual file or directory it points to. The pointed to file must also have a valid date.

A Feature is Not Enabled

FLEXlm codewords have both enable and expiration dates. If the codeword enable date is in the future with respect to the current machine date, then this error will occur.

First check the date on the computer. If it is not today’s date, correct it. On UNIX systems, the date can be set using the date command:

```bash
date mmdhhmm[yy]
```

For example, to set the date to 23 Sept, 2002 at 13:30, the command would be:

```bash
date 0923133002
```

If this still does not correct the problem, or if the date is correct, then request new codewords with an enable date set to today’s date.
Using RF Design Environment

**Cannot Connect to License Server**

If you see a flex.log file with the following errors:

- (lmgrd) Started agileesofd
- (agileesofd) Vendor daemon can't talk to lmgrd (cannot connect to license server) port 1700
- (lmgrd) Vendor daemon died with status 241
- (lmgrd) Since this is an unknown status, lmgrd will attempt to re-start the vendor daemon.
- (lmgrd) REStarted agileesofd (internet tcp_port xxxx)

Make sure that the lmgrd and agileesofd daemon are the correct version (version 8.2a or higher). The lmgrd daemon should have the same or higher version number as agileesofd. You can check version numbers as follows:

```
  cd $HPEESOF_DIR/licenses
  ./bin/lmgrd -v
  ./vendors/agileesofd -v
```

Make sure that the workstation is connected to a network or that the network connector on the workstation is properly terminated. FLEXlm will not work if the network connection is down or if the network services are not starting properly. Check all physical network connections to make sure that they are okay and look for errors during machine boot up. On HP 700 workstations, look at the /etc/rc.log file for errors.

Make sure that the agileesofd is being started successfully by lmgrd. If agileesofd cannot be started from the path specified on the VENDOR line in the license.lic file, this error will occur. Also make sure that the agileesofd file has execute permissions:

```
  cd $HPEESOF_DIR/licenses/vendors
  chmod 755 agileesofd
```
Address Already in Use

The tcp port number specified on the SERVER line in the license.lic file is in use by another process. Try the following: Kill any stranded lmgrd processes. Remove the /usr/tmp/flexlm/lmgrd.xxxx file that contains the tcp port you want to use. You can remove the entire /usr/tmp/flexlm directory if you are the only one using lmgrd on this machine, then restart lmgrd. If you still have a problem, try using a different tcp port number on the SERVER line in license.lic and then restart lmgrd.

Here is an example of properly configured SERVER lines:

```
SERVER joshua 2072EFE45 27000
SERVER isaiah 20472A3D3 27000
SERVER jonah 2052C6416 27000
```
Agilent EEs of Technical Support

Agilent EEs of worldwide technical support is available Monday through Friday. The toll-free North America hotline is open 6:00 am to 5:00 pm PT. Throughout Europe, the localized Online Technical Support Centers are open 8:30 am to 5:30 pm, local time; throughout Asia, the localized Customer Response Centers are open 9:00 am to 6:00 pm, local time.

The e-mail addresses for the various regions are listed below. However, for both the regional e-mail addresses and local telephone numbers for more than 25 countries, please refer to the Agilent EEs of Web site at

http://www.agilent.com/find/eesof/

North America
Phone: 1 800 47 EEs of (473-3763) · Fax: 818-879-6465
e-mail: eesof_support@agilent.com
Europe: e-mail: eesof-europe_support@agilent.com
Japan: e-mail: edasupport@pn.agilent.com
Korea: e-mail: eesof_korea@agilent.com
Asia: e-mail: eesof-asia_support@agilent.com
Index

B
bundles, license, 4-1

C
Cadence installation directory,
   modifications, 2-13
codewords
   installing, 3-2
configuring user accounts, 2-8

F
FLEXlm licenses
   setting up, 3-1

I
installation
   completing requirements, 4-1
   overview, 2-2
   procedure, 2-3
   requirements, 1-3

L
libraries, defining, 2-11
license.lic file
   updating, 3-23
licenses
   bundles, 4-1
   Cadence products, 1-9
   changing path settings, 3-27
   packages, 4-1
   setting bundle preference, 4-1
   setting up, 3-1, 4-1
   troubleshooting, 4-14

O
operating system
   checking, 1-4
   requirements, 1-3

P
printing and plotting, setting up, 4-9

S
startup script, 4-7